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P o r t i c o

Hold the Date! 

March 20: Dump it, Save it, 
Archive it: Using a Retention 
Policy to Manage your 
Firm’s Documents 

April 17: Lean Principles for
Lean Times 

May 14-17: 
EDSymposium14 
Nashville, TN 

May 29: Chapter Board of 
Directors’ Installation 

Best practices for managing good client relations 

attendees were from various 
disciplines including civil, 
planning, admin, and 
marketing. The discussion 
resulted in a list of external 
and internal opportunities 
for beginning and managing 
client relations, as well as 
best practices and 
philosophies. 

External Opportunities 

 Get involved with
industry associations 

 Identify associations that
are most appropriate/
of interest to you 

 Volunteer to be on a
committee – this creates 

(Continued on page 2) 

Consultants in the A/E/C 
industry know that good client 
relations play an important 
part in the sustainability of 
their business. The success of 
your current and future 
projects depends on positive 
client relations. 

Client relations are no longer 
the responsibility of just one 
or two people in the firm. 
Your employees might not be 
aware that they, regardless 
of position or years of 
experience, also have a role 
in developing or greatly 
enhancing client relations. 
Instilling a culture of positive 
client relations management in 
your office, and helping all 

employees achieve that 
culture, enables a win-win 
situation. 

Two firms, Parsons 
Brinckerhoff and BHC 
Consultants, share their best 
practices for managing good 
client relations. 

J onathan Kreitler, 
Marketing Manager at 

Parsons Brinckerhoff, 
moderated an in-house 
panel discussion on what 
employees can do to create 
and further client 
connections. The panelists 
were experienced project 
managers sharing a 
multitude of stories, and the 
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Are you a tweeter on Twitter? 

articles/127871. 

5. What words, including
keywords, will you place
in your bio? (You have
160 characters to work
with.)

6. What website do you
want to link to from your
business Twitter account?
(Answer: your website's
home page or if you
don't have one, your
LinkedIn account profile.)

7. What photo will you use
on your business Twitter
account? (Answer: the
same one you use on all
other professional social

(Continued on page 4) 

Do you feel 
left out when 
people talk 
about Twitter? 

Are you anxious to start 
tweeting but afraid that 
asking questions will reveal 
your lack of knowledge?  
Is your Twitter account set 
up, but looking silent and 
dismal?  

Answer these 10 questions, 
and you'll be well on your 
way to chirping up a storm! 

1. What name will you
choose as your Twitter
handle—company name
or personal name or
both? Learn more from

this Twitter ebook: 
http://blog.hubspot.com/
blog/tabid/6307/
bid/4495/Twitter-Handles-
Dos-and-Don-ts-and 
eBook.aspx . 

2. Where do I start? Sign
up at www.Twitter.com.

3. What graphic will you
use as your Twitter
background? What's a
background? Learn
more at twitter.com/
settings/accounts.

4. What graphic will you
use as your header?
What's a header? Learn
more at https://
support.twitter.com/

https://twitter.com/settings/account
http://blog.hubspot.com/blog/tabid/6307/bid/4495/Twitter-Handles-Dos-and-Don-ts-and ebook.aspx
https://support.twitter.com/articles/127871
https://support.twitter.com/articles/127871
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Good client relations (continued from page 1) 

a chance to collaborate 
with clients and other 
industry professionals 

 Maintain college 
connections 

 Volunteer (associations, 
client functions, 
conferences) 

 Maintain project contacts 
(during and after project 
work) 

 Become a resource to 
your internal/external 
clients (someone they can 
call with questions, 
doesn’t always have to 
be related to your 
project) 

 Get to know other firms 
and consultants in the 
industry 

 Check-in regularly with 
your clients (have a 
communication plan) 

 Bring technical staff to 
client meetings, it’s a 
good investment 

 Celebrate your clients’ 
successes: attend awards, 
galas, etc. 

 Consider bringing others 
to business development 
meetings with new 
contacts 

Internal Opportunities 

 Develop and use your 
internal network 

 If interested in a client, 
identify staff with 
connections to that client 
and learn how you can 
engage 

 Communicate 
 Be honest about how 

projects are going. Bring 

concerns back to the 
office for an open 
discussion on how to 
mitigate problems/
concerns. 

Best Practices/Philosophy 
 It takes personal 

initiative to develop your 
network 

 Quality project 
performance is the best 
and most important 
marketing 

 LISTEN to your contacts/
clients 

 Engage externally, but 
don’t overextend 

 Relationships are long-
term–they take time to 
develop 

 Clients have long 
memories (for both good 
and bad experiences) 

 Connect with the right 
people–internally and 
externally. Personality 
and communication styles 
are important 

 It’s important to 
recognize and control 
projects with issues 

 Engage with clients and 
contacts using social 
media (Linkedin, Twitter, 
etc.) 

 Follow up on leads  

J on Davies, Director of 
Client Services at BHC 

Consultants, recommends 
sharpening your networking 
skills, building a lasting client 
base, and implementing a 
business development 
schedule. 

 

Tips for more productive 
networking 

 Always bring a handful 
of business cards. 
Exchange cards with 
people that you meet. 

 Don’t be a wallflower. 
Walk over to people 
and make conversation. 

 Get a drink from the bar 
and hold onto it. This 
includes non-alcoholic 
beverages. Having a 
glass in your hand can 
help shy people 
overcome nervousness. 

 Do not sell while 
networking. Your mission 
is to make contacts, not 
to get a client to sign a 
contract. 

 If you’ve never attended 
a meeting of a particular 
group before, go with a 
friend who can introduce 
you to people in the 
group. 

 Dress in proper business 
attire. Your comfortable 
well-worn Dockers and 
golf shirt are not 
appropriate for a 
business gathering. 

 The best way to make 
friends and get people 
talking is to ask them 
questions. Instead of 
talking all about you, ask 
other people about what 
they do. 

 When you get back to 
the office, follow up with 
a short note or e-mail 

that says how much you 
enjoyed meeting them 
and let’s keep in touch. 
You might also enclose 
another business card 
and a brochure about 
your services. 

 Keep a database of 
contacts. List all the things 
that you learned about 
the person, e.g., family, 
hobbies, interests, etc. 

 When making referrals, 
think of the people in 
your database first. 
Sending a lead or 
business to a person is a 
great way to cement the 
relationship between 
you. 

Keys to building client 
relationships 

 Seek out clients who can 
provide a steady flow of 
assignments rather than 
an occasional project. 

 Invest your time wisely. 

 Build a personal 
relationship. Visit with the 
client now and then. An 
occasional cup of coffee, 
lunch or dinner is a good 
way to get to know 
someone. 

 Participate in client 
activities. Accept any 
invitations you receive to 
attend Christmas parties 
or similar events. Make 
sure you say hello to the 
client at conferences and 
other industry events. 
Drop by clients’ booths if 

(Continued on page 3) 
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Good client relations (continued from page 2) 

decision maker—and 
who doesn’t. And they 
might be promoted one 
day and become your 
client. 

 Never be rude or lose 
your temper. Always be 
patient, courteous, and 
friendly. 

 Remember clients have 
all the power. Clients can 
choose to ‘fire’ you at 
any time, for any 

reason…or for no 
reason.  

Top 10 things to implement 
tomorrow  

1. Plan next week this week. 

2. Plan one business 
development task every 
day and DO IT! 

3. Call at least one prior 
contact every week. 

4. Contact at least one 
prospect every week.  

5. Debrief on proposals and 
projects regularly. Win or 
lose! 

6. Analyze your competition 
for each market. Answer 
three questions:  Who is 
getting the jobs?  Why 
are they beating your 
firm?  How do their 
marketing and sales 

they’re exhibiting at 
conferences. 

 Send your client copies of 
pertinent news articles 
and items that you know 
they are interested in.  

 Pick up the phone or send 
an e-mail to say hello 
every now and then. Just 
say hello–don’t ask about 
new business. 

 Cultivate relationships 
with as many people in 
the client organization as 
you can. Even people you 
think are unimportant can 
have a major say over 
whether you get hired. 

 Be especially considerate 
of secretaries, assistants, 
and receptionists. They 
wield a lot of influence 
over who gets into the 

efforts differ from yours? 

7. Call your last 10 clients 
and ask them for a 
referral or help them 
solve a current problem. 

8. Solicit letters of 
recommendation from 
clients and use them as 
marketing tools. 

9. Write a letter to all your 
present clients simply 
thanking them for their 
business.  

10. Make a list of your 
network contacts. Contact 
one each day to 
exchange lead 
information. Find a way 
to help them as this is the 
best way to build a 
strong network.  

 Technology Transfer: Did Your Mouse Die? 

What do you do when your 

mouse dies?  You press the 

Alt key. 

While in Word (or other 

Microsoft programs), press 

Alt to display the short-cut 

keys to continue working 

when your mouse decides 

to call it a day. 

1. Press the Alt key first, to enable the short-cut keys:  F for File, H for Home, N for Insert, P for 
Page Layout, W for View, etc. 

2. Then, press any of those short-cut keys to activate the sub-menu items. For example, to Save 
the document, press F to open the File menu to get to the short-cuts for Save and Save As. 

3. Or, press N to open the Insert menu, and from there you can insert a table (press T), insert a 
picture (press P), insert a hyperlink (press I), or insert a page break (press B). 
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the beginning of the season I 
told our guys, ‘Hey, why not 
us?’”   

Our chapter also started 
2014 on a high note with 
some excellent programs; yet, 
we are facing a critical time 
and we have decisions to 
make. I am very proud of 
what we have accomplished 
as a chapter this year, but we 
are struggling with the same 
problems of membership 
growth, financial support, and 
leadership succession. At our 
February business meeting, 
we elected a nominating 
committee to select officers 
for the 2014-2015 board 
year. We also started a 
discussion on “Why is SDA 
membership valuable to me?” 

I want to hear from each and 
every one of you: 

What do you get out of your 
membership? 

What are you not getting 
that you wish you were 
getting? 

We are planning an evening 
to get together and talk 
about our chapter and its 
direction for the coming year. 
I want to be able to give the 
new board some ideas about 
where we can scale back, or 
where we can beef up, or 
where we can change what 
we’re doing to make each of 
you a true believer in, and 
marketer of, SDA.  

 

 

Hello, SDA. 

2014 started off on a high 
note in Seattle with the Super 
Bowl XLVIII win. Even people 
who don’t usually follow 
football could not help but be 
affected by the enthusiasm 
that brought our city together. 
I was particularly inspired by 
something Russell Wilson said 
in a post-game interview:  “At 

I am challenging each of you 
to start thinking: 

“Why not us? 

Why not me? 

What am I willing to put in 
to receive the value I want?” 

As a chapter, we cannot rely 
on the same people to 
continue to do the same jobs 
over and over. It’s time to 
evaluate where we are and 
where we want to be, and 
working together as a team, 
we can get there.  

I’m looking forward to 
hearing from you! 

 

Stacy Rowland, CDFA 

Twitter (continued from page 1) 

a way for you to connect with 
clients without them feeling 
like they're being sold to. 

After you create your Twitter 
account, you have an 
opportunity for your staff to 
call your AAA clients to learn 
what their Twitter handles are 
and then invite them to follow 
you. 

Other ways to notify clients 
that you're ready for them to 
connect with you on Twitter 
are to mail them a postcard 
announcement, put an 
announcement notice on your 
blog, and create links from 
your website to your social 
networking sites. 

Of course, don't use Twitter or 
any other social networking 
platform if you aren't sure 
how to do so in a compliant 
manner, consistent with your 
firm's social media policies. 
Always check with your 
Compliance Department 
before doing something new 
on any social media venue. 

 

©2013 Maria Marsala guides 
independent financial advisors to 
reach their 5-year business and 

personal goals in 
24 months. She is a 
business coach, 
speaker, and a 
former Wall Street 

networking sites.) 

8. What will your first tweet 
be? 

9. Will your account be 
public or private? Will 
you protect your site or 
not. Learn more here: 
twitter.com/settings/account. 

10. Who will you invite to 
connect to you on Twitter?  
Let me know your handle 
[and I will follow you]. 
You can follow me at 
@mariamarsala. 

Bonus Tip: 
Social networking allows you 
to connect with your clients on 
a more personal level, too. It's 

Trader. Named one of the Top 30 
International Coaching Gurus in 
2011, Maria has been recognized 
as a thought leader whose ideas 
have been published in Financial 
Planning Magazine, RIA Biz, 
Advisor Max, Dow Jones, The 
Street, Entrepreneur Magazine, 
and numerous books, trade 
journals, and magazines. She has 
authored four business-building 
workbooks including, Attracting 
Clients You Love Working With: 6 
Steps to a Profitable Client Base. 
Did you find this article thought 
provoking? Get more delivered 
directly to your inbox every two 
weeks: Sign up here. 
 

https://twitter.com/settings/account
http://www.elevatingyourbusiness.com/


Page 5 

P o r t i c o   
S E A T T L E  C H A P T E R ,  S O C I E T Y  F O R  D E S I G N  A D M I N I S T R A T I O N  

Spotlight on members:  Sarah Shults and Renae Howard 

her position and the overall 
fluctuation in workload can be 
a challenge when it comes to 
balancing work and home 
demands. 

Sarah joined SDA in 2008 for 
the same reasons many 
members do: the networking 
and educational 
opportunities. She says that 
an advanced Excel class 
would be great; she’s looking 
for tips and tricks to make the 
program easier and more 
useful in her daily tasks. 

One of Sarah’s goals for 
2014 is to get CDFA certified. 
In her spare time, she enjoys 
painting and cycling.  

 

 

 

 

Renae Howard, CDFA, is not 
only an SDA member; she’s 
an entrepreneur, running her 
own bookkeeping business, 
Watching the Bottom Line, 
since 2004. 

In addition to full-charge 
bookkeeping, Renae provides 
occasional HR and office 
management/ administrative 
support. Her biggest 
challenge is finding enough 
time to sleep and exercise, 
while still meeting deadlines 

Located in Seattle, Weinstein 
A|U really keeps Sarah 
Shults hopping! 

 
 
 
 
 
 
 
 
 
 
 
 

 
Not only is Sarah a Principal, 
she is the Controller and IT 
Manager, and she also 
handles all of their HR 
functions and provides 
contract review and 
negotiation. 

Sarah has been at Weinstein 
for almost 14 years, and 
admits that the demands of 

and most importantly, raising 
her son. All of these demands 
don’t leave her much time for 
her hobbies, which include 
dancing, baking, and 
gardening. 

Renae joined SDA in 1997 at 
the recommendation of her 
employers, who first saw the 
benefits of membership within 
their office manager, and 
who encouraged new hires to 
join as well. She was drawn 
to the educational 
opportunities and mentorship 
from fellow members, and 
would love to learn more 
about writing Employee 
Handbooks. 

For SDA, Renae would like to 
see the Seattle Chapter 
develop more leaders, and 
have more rotation among 
the board members.  

SDA members: Check out this local opportunity! 

 

 

 

 

 

The Nominating Committee will be looking 
for candidates to serve on the Seattle 
chapter board of directors for the 2014-
2015 term. 

 President 
 President-Elect 
 Vice President 
 Recording/Corresponding Secretary 
 Treasurer 
 Director(s) 

Here’s your chance to join a team that is 
dedicated to helping the chapter (and the 
organization as a whole) further its 
mission. 

Are you ready for a new (another) 
opportunity? 

Please contact the Nominating Committee, 
Shannon Soady (ssoady@dlrgroup.com), 
Renae Howard 
(renaehowardbookkeeper@gmail.com), or 
Laura Preftes (laurap@lpdengineering.com) 
to express your interest in running for 
office. Or, to learn first-hand about 
what’s involved when you serve on the 
chapter’s board of directors, contact any 
of the current board members (see last 
page for contact information). 

Take this quiz. 

It’s time for me to grow (enhance, strengthen, 
develop) my leadership skills. 

 Yes     No 

I am open to career-advancing strategies. 

 Yes     No 

I am looking for a new or different, professional 
challenge.  

 Yes     No 

I want to get involved in the A/E/C industry. 

 Yes     No 

If you answered yes to any those 
questions, SDA has the perfect 
opportunity for you! 
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Who is shaping your policies, procedures, and practices? 

ways to engage all staff 
(social media, volunteer 
programs, beer Friday 
events, as well as summer 
picnics, etc). There has been a 
little bit of training on 
sensitivity, but for the most 
part it has been about 
principals/managers 
respecting the differences. 
The firms I've seen where this 
hasn't been done keep losing 
talented, newer staff because 
the more experienced 
generations don't know how 
to understand, motivate, and 
engage them. The turnover 
keeps hurting their project 
success and ultimately their 
profitability.  

Tracey Bessellieu (Parsons 
Brinckerhoff):  Studies show 
that Generation X and Y are 
the largest population of 
employees in the workplace 
today with millennials quickly 
progressing to make up 40% 
of organizations in 2020. At 
Parsons Brinckerhoff, Gen X 
and Y combined, constitute 
over 50% of our U.S. 
population. This growing 
demographics has given us 
the opportunity to look at a 
few key areas and make 
significant changes to 
accommodate these groups.  

The way they learn: Gen X 
and Y prefer to learn in 
smaller classrooms or by self-
paced study. 

Parsons Brinckerhoff offers: 

360 Collaboration: 
 Blog style collaboration 

(Continued on page 7) 

What’s the make up of your 
firm’s staff? All Baby 
Boomers? Predominately 
Generations X and Y? A nice 
balance of all three 
generations? 

Have you changed your 
policies, procedures, or 
practices because of the 
differing expectations or 
demands from your 
diversified employees? 

According to surveys, the 
younger generations want 
and expect flexible work 
hours and the ability to check 
their smartphones whenever 
they feel like it. In fact, one 
survey by Cisco* showed that 
Gen Y’s won’t work at a firm 
if the firm bans access to 
social media. 

We were curious to find out 
what A/E/C firms have done 
or are doing, so we asked 
them to share what changes, 
if any, have been made to 
accommodate the 
generational differences.  

 

Gretchen Renz 
(Bernardo|Wills):  Some of 
the changes we've made 
weren't designed specifically 
to meet Gen X needs or Gen 
Y needs, but were in response 
to our changing demographic 
(more families in the office) 

and new technologies. In 
order to appeal to our Gen X 
staff, we have instituted a 
variety of flexible schedule 
options to help achieve some 
sort of work/life balance. 
We have also made it 
possible to log into the 
network remotely so that staff 
can work at home in an 
emergency. For our Gen Y 
staff, we've recognized that 
putting down the cell phone is 
not possible, so we've 
relaxed the rules for personal 
device use, and made syncing 
systems and forwarding email 
to personal devices easy. In 
response to Gen Y's 
collaborative work style, we 
designed our new office with 
lots of break out space and 
desk arrangements that 
promote collaboration. The 
changes have improved 
morale and increased job 
engagement for all 
generations.  

Dana Thompson (Callison):  
We actually have not made 
any adjustments or changes 
to accommodate those three 
generations. We have made 
the shift to hire the brightest 
and most talented recruits 
coming out of college.  

Anonymous in Colorado:  
No changes have been made 
formally at my firm. The 
culture here is pretty much, 
“fit in with our culture or 
leave.” However, I have 
noticed over time that some 
obvious gen-related 
behaviors seem to be quietly 
accommodated for those few 

who exhibit them. Typically, 
it’s looking the other way 
when they work highly 
flexible work schedules. The 
attitude is that “I work plenty 
of extra hours, and the firm 
should accommodate me 
when I want to come in late 
or leave early.”  

Stacy Rowland (Berger 
Partnership):  My firm allows 
flexibility in work hours. 
Employees can come and go 
at the times that suit them 
best, as long as the work gets 
done and meetings aren't 
missed. I don't know if this 
policy was instituted 
specifically for the younger 
generations, but it does seem 
to keep people satisfied and 
pleased with their work 
situation.  

Shannon Soady (DLR 
Group):  Our firm is making a 
conscious effort to court the 
younger generation because 
they will be our next leaders. 
By investing in continual 
software upgrades, a more 
casual workplace, more 
flexibility, and lots of 
leadership opportunities, 
we're trying to ensure they 
stay with us long enough to 
really learn our business and 
firm so they can effectively 
lead the firm in the coming 
years. And, we're seeing 
more of our older, longer 
term employees retire.  

Renae Howard (Watching 
the Bottom Line):  The firms I 
have worked with [my clients] 
have made an effort to build 
community in a variety of 
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Who is shaping your policies, procedures, and practices? (continued from page 6) 

 Allows employees the
opportunity to learn about 
Parsons Brinkerhoff and 
build on their career 
development and goals 

 Acknowledges the
importance of welcoming 
our new employees and 
showing them how their 
contributions fit in to the 
organization  

 Gives the younger
generation direct access to 
Senior Leadership  

Work Environment: 
 Moving away from

standard cubicles, 
conventional meetings 
rooms, and private offices 

 More open, collaborative
work stations 

 Energy efficient
environment (sensor-
sensitive lights, filtered 
water, recycling) 

 Flex-time schedules vs. the
traditional 9 to 5 work 
day; employees can 
choose the times that are 
more effective to their 
work style 

Technology: 
 Personalization is a large

part of individuals’ 
lifestyles today. With 
BYOD (Bring Your Own 
Device), employees can 
keep their personal cell 
phone (iPhone, Galaxy, 
Droid, etc.) and still have 
access to their email and 
contacts.  

 Shows flexibility aside
from the rigid 
“traditionalist” Blackberry 
model 

 Reduces frequency of
carrying around two cell 
phones 

Steve Weinberg (Glumac):  In 
2012, I presented a session to 
Glumac’s Board and 
Principals on generational 
differences and the impact I 
thought it was having, and 
how a mentoring program 
would nurture and thus help 
retain staff. We had 
experienced a high turnover 
among the younger staff 
coming into the firm.  

We talked about the 
generational differences, and 
the negative impacts of turn-
over, such as:  

 Re-hiring

 Re-training

 Project interruption and
delays 

 Client dissatisfaction

 Lowered morale

 Company reputation
(“churn and burn”) 

 Disruption and instability
of work environment 

 Brand degradation

 “Brain drain” (loss of
project knowledge) 

 “Un” sustainability

 Detailed information at the
click of a mouse 

PB University: 
 Self-paced online learning

on relevant topics 
 Courses available outside

of our network allow for 
flexibility in the time and 
place you take the course 

Tuition Reimbursement: 
 In a highly competitive

marketplace, we offer 
tuition reimbursement for 
licenses, certifications, 
degrees, etc.  

 Allows our employees to
continue their education 
and add value while 
employed with PB 

Professional Growth Network 
(PGN):  Through PGN, Gen X 
and Millennials: 
 Are given recognition for

their contributions 
 Work collaboratively with

our Senior Leaders on 
complex issues that affect 
our strategy and goals 

 Create a forum of
knowledge-sharing on a 
global level with their 
peers  

Recognition:  We have and 
participate in programs 
offering emerging 
professionals the opportunity 
for exposure. For example: 
 Emerging Paper

Competition 
 Chairman’s Prize for

Innovation 
 Enginuity Contest

LAUNCH–our graduate 
onboarding program: 
 Builds a cohort for new

hires 

I also talked about the 
oversimplified view of the 
accounting/billing mentality, 
which is staff are either being 
utilized (billing time to a 
project) or are not being 
utilized. The “not” is called 
overhead, and I believe there 
is a negative perception to 
that. 

The industry standard is that 
overhead should be 
minimized and utilization 
should be high, and overhead 
becomes a generic bucket for 
everything that is not billable 
(or good) and is blandly and 
blindly fuzzy. Even one of our 
principals shared his concern 
that “overhead activities 
should not be a default for 
lack of productivity.” 

What I hope to see is that 
overhead moves from an 
opaque, black box of 
“wasted” activities to a value-
added and trackable set of 
investments in our future. 
Those investments are 
education, marketing, and 
mentoring. 

As a result of the presentation 
and discussion, we started an 
internal mentoring program 
that connects our newer, more 
junior employees with more 
seasoned employees. Our 
mentoring program works, 
and we have top-down 
support from our CEO, who is 
personally very "tuned into" 
the generational issues. 

Twila Wittman (Wood 
Harbinger): We have a 
committee that takes 

(Continued on page 11) 
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Dena Berrios is a Senior Certified Administrator and works in the Detroit office of Parsons Brinckerhoff. She has been 
with the firm for nine years. She began serving as a mentor in 2008, and has experienced good and not-so-good 
mentor/mentee relationships. Her recent and most successful experience as a mentor began in 2010 and continues to 
this day. This article was originally published in a Parsons Brinckerhoff internal newsletter (All Points Bulletin...Project 
Administration CoP 047, Winter 2013). Reprinted by permission. 

 

Mentoring can be fun and exciting but over time, it can easily become tedious and boring. Like any relationship, it all depends on 
how much effort you put into keeping it exciting that will make a difference. Accomplishing this takes some thought, a little 
creativity, and a bit of planning.  

Assuming you have had a mentor/mentee relationship for a while now, you have already spent time discussing the basics that help 
you get to know one another and established a trusting relationship where the mentee is comfortable coming to you for advice. 
Since this relationship has evolved, it is easy for the regular conversations to become unfocused, off growth areas, and even a bit 
boring. When this started happening with my mentee I began looking for new ideas to focus our conversations on growth areas, 
but still have something new to discuss.  

While participating in a local “mentoring month” event, I received a list of ice breaker topics that could be used for building a 
mentee/mentor relationship. I really liked the idea of having thought provoking questions that could help inspire a real discussion 
with my mentee. Because any relationship takes effort from all parties involved, I reached out to my mentee and we did a 
planning call. We took the list that was already put together, reviewed it for what we liked, added a few items, and tweaked it a 
bit more to make it suitable for us; a predetermined script is not exciting at all. We settled on 11 topics, one per month, which 
became our monthly “Coffee with Your Mentor” focus. The final month we looked at our accomplishments for the year, goals for 
the following year and discussed how those topics helped us grow. Using this idea was an exciting way to keep the conversations 
from getting stale and focusing our calls on the business at hand, but still allowed us to openly transition the conversation to other 
areas.  

Some of the questions included: 
 Who is in your personal and professional network?  How do you build that network? 
 How do you manage work/life balance? 
 What books have influenced your ideas and thoughts the most? 
 What are your strengths?  What are your weaknesses? 
 What is it that you really want to be and do?  
 What are you doing well, and not well, to get you there (follow-up from previous topic) 
 If you could change your life in one way, what would you change? 

Although this idea was very successful for us, it was important to think of a new and creative idea for the following year so that 
our calls would continue to focus on growth in a new way. As the year came to a close I found myself on the lookout for another 

(Continued on page 9) 

Keeping the mentoring relationship exciting 

Sound Bites  
I wanted to thank you for your field-shading tip [Dorothy Skan’s Microsoft Word presentation to the 

Seattle Chapter]. I was just working on a document, needed to shade a field, and whipped out your 
hand outs. Yay!!  (Audree DeAngeles, Senior Technical Editor, Aspect Consulting) 
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Mentoring (continued from page 8) 

idea that would keep us engaged but still inspire thought provoking discussions. Keeping an eye open for ideas to share with my 
mentee, I found a great book on procrastination that I hoped would inspire thought and analysis for personal growth areas. This 
book, “It’s About Time! Six Styles of Procrastination and How to Overcome Them” by Linda Sapadin and Jack Maguire, helped to 
identify characteristics of our individual procrastination styles and ways to move past those; a great discussion topic!  I ran across 
a great article on why procrastination is good…another discussion topic for sure!  Since procrastination is related to productivity 
that became the next topic area to inspire thought.  

I felt it was important to change the set-up of the call to a focused theme that still inspired thought and reflection. The new focused 
themes then became the planned topics of the following year.  

Some of the themes included: 
 Procrastination: What is your procrastination style? How did this help you reflect on ways you can improve your work and

home life?  What areas in your life can procrastination be good?  How? 
 Productivity: Using what you have learned about how you procrastinate, what

changes have you made to increase your productivity? 
 Planning: What tools do you use to manage your work and home life and get

everything accomplished? 

While all of our calls had a planned topic, it was only there to assist the flow of 
discussion and self-reflection. All of our scheduled calls would cover much more than the 
topic at hand, and we also had frequent conversations in between those calls to discuss 
anything that was happening at that time.  

Being a mentor is a very rewarding experience, and you quickly become friends with your mentee as they turn to you to help 
guide them. You learn about their family, their hopes and dreams, goals and their life. You become a confidant that they trust with 
information they don’t share with just anyone. This is a trust that builds over time through open discussions and should not be 
treated lightly. Spending time thinking of creative ways to help your mentee grow will in turn have you reflecting on those same 
topics; your experience and guidance will be needed throughout the relationship to help the growth. You are the one that will 
help them learn things about themselves that will help them see “a possible future, and believe it can be obtained.” 

Over time this mentor/mentee relationship will transform even further into one where the mentee can even become the mentor. 
When the mentor begins turning to the mentee for advice and sharing their own answers and reflections to these topic questions, 
the relationship transitions to another level of mentoring. This new relationship is mutually rewarding and encourages growth and 
self-reflection from both parties as they grow and learn.  

Although not all mentoring relationships experience this type of success, many do. It is important to continue to find ways to keep 
the relationship exciting by looking for new ways to inspire growth and self-reflection. As I read newspaper articles, blogs, books 
and magazines, I am always on the lookout for things that I can share with my mentee that will inspire exciting conversation. 

A mentor empowers a person to 
see a possible future, and believe 
it can be obtained.  

-Shawn Hitchcock 
Illinois State University 

Don’t forget—early bird registration for EDSymposium14 ends March 15! Don’t 
miss out on more than 18 continuing education credits, plus the other activities 
planned, such as the Awards banquet, installation of the new national Executive 
Committee, and the Diamonds and Denim party. And don’t forget about the national 
scholarships that provide funding to attend. 

The EDS14 brochure outlines everything you need to know; check it out: 

http://www.sdanational.org/?page=EDS14Registration. 

EDSymposium14:  May 14-17 in Nashville 
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Wouldn’t it be wonderful if you could change the plain, old boring footnote separator (the horizontal line that appears above 
footnotes) in your Microsoft Word documents? Or easily fix the separator if for some reason it shows up centered on the page? 
Dorothy Skans (Production Document Specialist at Parsons Brinckerhoff) shows you first how to fix the separator, and then how you 
can change the look of the separator. 

Fixing the separator 

1. Open the Word document that contains the Footnote

2. Make sure you are viewing the document in Draft mode (View > Document Views > Draft)

3. Click on Show Notes (References > Footnotes > Show Notes)

4. Click on the down arrow in the Footnotes window that opens at the bottom of the document

5. Click on Footnote Separator from the drop down menu

6. Apply changes just as you would any text* (the two most common fixes Dorothy typically has to make: remove the space
after the line, and change the left margin to 0)

7. Click on the “X” at the right side of the Footnotes window to close the window

Changing the plain, old boring separator 

If you want to get fancy with your separator, follow steps 2 through 5 above, and then: 
 Highlight the separator

 Click on Clip Art icon (Insert > Illustrations > Clip Art)

 Type “divider” in the Search for: window and click Go

 Scroll through the samples and click on your choice (you won’t actually see the new divider in that Footnote Separator
window until you change back to Print Layout mode) 

*The footnote separator defaults to “Normal” style. Once you make your changes to the separator, you can create a new Style
for later use: 
 Click on the separator
 Go to Styles (Home > Styles > New Styles)
 Enter “Footnote Separator” in the Name: box and click OK

Formatting the footnote separator line (Microsoft Word) 

Two fancy 
footnote 

separators 
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About SDA 
For over 50 years, the Society 
for Design Administration 
(SDA) has promoted education 
and best practices in 
management and professional 
standards of design firm 
administration. SDA 
membership stretches across 
the United States and 
Canada, and is composed of 
personnel working in the 
design industry for 
architectural, engineering, 
construction, and related 
industry firms. 

 

 

 

 

 

 

 

Like us on Facebook 

National SDA: 

www.sdanational.org 

Look, click, learn. 
Seattle Chapter SDA: 

www.sda-seattle.org 

Portico is published quarterly. Please send 

comments, suggestions, announcements 

and articles to the Editor Judy Beebe at 

beebe@pbworld.com. 

Board of Directors 

SDA Seattle Chapter  
2013-2014 
 

Stacy Rowland, CDFA   
President 

Pakalana Patterson, CDFA 
Treasurer 

Renae Howard, CDFA   
Vice President 

Lois Diemert, CDFA   
Secretary 

Susan Vestal, CDFA   
Director 

 

Next Up 
 

MAR 

20 

Dump it, Save it, Archive it: Using a Retention Policy to Manage your Firm’s 
Documents. Presented by Catherine Blake (Callison). 

MAY 

29 

Chapter Board of Directors’ installation. Location and program TBD. Note: This is 
being held on the fifth Thursday of May. 

Check our website for more details (sda-seattle.org). Seattle Chapter events are also published in the Puget 
Sound Business Journal, AIA eNews, Seattle P-I, and the Daily Journal of Commerce. For questions about any 
of the chapter programs, or if you have suggestions for SDA programs, please contact Renae Howard at 
renaehowardbookkeeper@gmail.com. 

APR 

17 

Lean Principles for Lean Times. Presented by Patrick Watson (Jacobs). 

suggestions (anonymous or not) from staff, and from those suggestions we now have, for 
example: 

 Paid bereavement leave 

 Reimbursement for gym fees 

 Employer matched charitable donations up to $200 a year 

We also hold ice cream socials, picnics, and an end-of-the-year party, and we provide flu shots 
and support a variety of charitable causes. 

While there may not be specific policies in place for the newer generations, we try to have 
flexible hours for those that need to take time off for family issues and additional educational 
opportunities, or if people need to work outside the standard 8 AM to 5 PM. We encourage 
people to use their personal or vacation time. For many departments, if warranted, working 
remotely from time to time is acceptable. We have "casual Fridays." Our leadership has an 
open-door policy, and encourages suggestions. We hold quarterly meetings, department 
meetings, and individual meetings to keep staff informed of company news. 

All in all, it's one of the more flexible places I have ever worked, and in that sense, it is 
appealing to a variety of generations.  

* Data from Cisco: http://tinyurl.com/nxd2x6w 

Generational employees (continued from page 7)  

http://www.facebook.com/#!/pages/SDA-Seattle-Society-for-Design-Administration/194667713888886?fref=ts
http://sda-seattle.org

